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2 Overview
The DRV8434SEVM is a platform to support prototyping and evaluation for the DRV8434S, a medium-voltage
dual H-bridge driver for stepper-driving applications. The DRV8434S drives a single bipolar stepper with
microstep settings ranging from full-stepping to 1/256 resolution with internally-regulated microstep levels. It
provides a variety of programmable decay settings and can detect stall conditions while driving.

The EVM uses an MSP430™ microcontroller and a USB interface chip to manage communication from the GUI
software application installed on a PC computer with Windows®. The GUI sends serial commands to the
MSP430 to control the device signals, monitor faults, read and write SPI registers, and drive a stepper motor by
issuing the step commands at the desired rate. This document describes the software and tools used to evaluate
DRV8434S device for stepper motor driving on the DRV8434SEVM.
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3 Hardware and Software Setup
The hardware (HW) and software (SW) tools that follow are required for the evaluation of DRV8434S:

• DRV8434SEVM
• Stepper motor
• Voltage supply from 4.5 V to 48 V, rated to support the motor specifications
• Micro-USB cable
• DRV8434S EVM GUI installer

For details on hardware connections refer to the DRV8434SEVM User's Guide.
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4 GUI Application
4.1 Installation
• To install the standalone GUI application on a Windows computer, use the DRV8434S_x.x.x_installer_win.zip

file, located inside the DRV8434SEVM software.zip file which can be downloaded from DRV8434SEVM
software link, x.x.x is the GUI revision number.

• Extract the zip file. Double click the executable file to install the GUI application. Be sure to install the GUI
composer runtime. If the computer's firewall prevents the "download from website” option for the GUI
composer runtime installation, download the GUI composer runtime installer from, https://software-
dl.ti.com/ccs/non-esd/gui_composer/runtime/gcruntime-8.0.0-windows-installer.exe. Use the "Install from File"
option to install the GUI composer runtime.

• During GUI application installation a pop up window will appear as shown in the Figure 4-1. Click on 'Install'
to install the USB driver required for the DRV8434SEVM operation.

Figure 4-1. Installation pop up window

4.2 Getting Started with DRV8434S EVM GUI
The DRV8434S EVM GUI allows the user to configure various settings required for driving a stepper motor using
a DRV8434SEVM. The GUI lets the user set the motor speed, control the direction and the number of steps to
spin, configure stall detection settings, and monitor the device status.

• Connect the stepper motor to the EVM.
• Plug in the DRV8434SEVM USB cable to the PC.
• Switch on the motor power supply.
• Click on DRV8434AEVM GUI shortcut either on the desktop or from the start menu to run the GUI

application.

For additional details on hardware connections refer to the DRV8434SEVM User's Guide.

4.3 Use the DRV8434S EVM GUI
• The Application opens with home page shown in the Figure 4-2.

The GUI application will attempt to establish communication with the DRV8434SEVM. A message showing
‘Connecting to target…’ will be displayed in the hardware connection status pane at the bottom of the screen.
Upon successful connection, ‘COMx:115200 Hardware Connected.’ message will be displayed in the status
pane.
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Figure 4-2. DRV8434S EVM GUI (Home Page)

If the GUI fails to connect to the EVM, the hardware connection status pane will show the message ‘Hardware
not Connected.’.

If the GUI is opened prior to connecting the EVM to the computer, follow the directions displayed in the status
pane, see the Figure 4-3.

Figure 4-3. Reconnecting the EVM

If multiple EVM boards are connected to the computer, the first matching device will be connected automatically.
In order to switch to another EVM:

Click Options -> Serial Port. A serial port configuration popup is displayed as shown below in the Figure 4-4.

Choose the appropriate port and baud rate.

Click OK.
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Figure 4-4. Serial Port Configuration

Once the desired EVM is connected, the home page will show the message ‘Hardware Connected.’ with a green
check mark at the top left of the GUI Motor Driver page as shown in the Figure 4-2.

Click on the ‘Stepper Motor Control’ thumbnail to open the stepper motor control page.
4.3.1 Stepper Motor Control Page

The Stepper Motor Control page (shown in Figure 4-5) includes various controls and settings to drive a stepper
motor. Hovering the mouse pointer over the (?) icon to the right of a control or setting displays a brief description
about it.

Figure 4-5. DRV8434S EVM GUI (Stepper Motor Control page)
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4.3.1.1 Stepper Control Modes

The GUI allows the user to control the stepper motion profile in two modes – Speed Mode and Step Mode. To
toggle between the modes, use the toggle button at the top of the screen.

4.3.1.1.1 Speed Mode

The Speed Mode enables the driver to spin a stepper motor continuously at a desired target speed. The user
can configure the starting speed, stopping speed, acceleration rate, and the target speed. Stepper motor
controls are active only when ‘Motor Driver' is set to Awake. ‘Start Input-based STEP’ button is active only when
‘Driver Outputs' is set to Enabled. When the ‘Start Input-based STEP’ button is clicked, the motor begins to spin
at the starting speed and accelerates to the target speed according to the configured acceleration rate.

When the ‘Start Input-based STEP’ button is clicked, the microcontroller generates step pulses at a rate
specified by the 'Starting Speed' PPS (pulses per second) parameter. When ‘Stop Input-based STEP’ is clicked,
the motor starts decelerating at the ‘Acceleration Rate’ configured, to reach the stopping speed and eventually
stop. The configuration is displayed by the embedded graph of the GUI.

During acceleration and deceleration, the step PPS signal is updated by the microcontroller every 32 ms based
on the integer value of the 'Acceleration Rate' PPSPS (Pulses per second, per second) divided by 32 ms. The
step rate increases by the calculated value until the target speed is reached.

The starting speed must be less than or equal to the target speed. If the starting speed and target speed are
equal, acceleration will be skipped. The stopping speed must also be less than or equal to the target speed.

After the target speed PPS value is reached, the acceleration stops and the motor continues to spin until the
'Stop Input-based STEP' button is clicked. Immediately after the 'Stop Input-based STEP' button is clicked, the
microcontroller performs the same actions as it did during acceleration, but in the reverse order to decelerate the
motor until the stopping speed PPS value is reached. The motor stops spinning when the stopping speed PPS
value is reached. Figure 4-6 shows the acceleration and deceleration graph and the settings and controls of the
Speed Mode.

Figure 4-6. Settings and Controls of the Speed Mode

4.3.1.1.2 Step Mode

The Step Mode enables the driver to spin a stepper motor by a desired number of steps. The step mode can be
activated by clicking "Step" on the "Control Mode" widget located on the top left of the Motor Control page.
Stepper motor controls are active only when ‘Motor Driver' is set to Awake. Start’ button is active only when
‘Driver Outputs' is set to Enabled. When the ‘Start Steps’ button is clicked, the motor starts spinning at the
starting speed and accelerates with the configured 'Acceleration Rate' to reach the target speed, until the 'Steps
to Stop' value is reached. At this point the motor decelerates with the configured 'Acceleration Rate' until the
number of steps is completed after which it stops.
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The acceleration and deceleration profiles work similarly to the Speed Mode, except the number of steps at
which the deceleration starts and the motor stops are a function of the 'Steps to Stop' and 'Acceleration Rate'
parameters.

In addition to the input parameters of the 'Speed Mode' described in Section 4.3.1.1.1, two additional parameters
are included in the step mode:

• Number of Steps: This parameter is the desired number of steps the stepper motor will spin.
• Steps to Stop: The number of step pulses issued to the driver are constantly monitored. When the current

step is equal to the 'Steps to Stop' parameter, deceleration is started. If the value of the 'Steps to Stop'
parameter is larger than the number of steps, the motor stops abruptly without deceleration after spinning the
desired number of steps.

The configuration is displayed by the embedded graph of the GUI. The graph is only representative of the speed
profile and does not dynamically model the value of the 'Number of Steps'. If the 'Reciprocate' slider is enabled,
the stepper motor spins the set number of steps in one direction, then switch direction and spin the set number
of steps in the opposite direction, repeating these actions continuously until the 'Stop Steps' button is clicked.
Figure 4-7 shows the acceleration and deceleration graph and the settings and controls of the Step Mode.

Figure 4-7. Settings and Controls of the Step Mode

Figure 4-8 graphically demonstrates three stop condition examples based on the target speed, acceleration rate,
stop speed and the number of steps parameters.
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Figure 4-8. Stop Condition Examples
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4.3.2 Decay Mode

Decay refers to how the driving currents recirculate in H-bridge FETs during the off time. Using the GUI, the user
configure the decay mode. To configure,

• Click the Decay Mode button at the top center-right of the GUI. A popup appears as shown below in the
Figure 4-9.

Figure 4-9. DRV8434S EVM GUI (Decay mode)

• Decay mode and appropriate TOFF values can be configured in the popup. The configurations can be
visualized in the graph shown. For information about the different decay modes, refer to the DRV8434S
Stepper Motor Driver datasheet.

4.3.3 Fault Monitoring

The fault monitor section at the right side of the GUI allows the user to configure monitor the various device
faults. The LED widget stays green when a driver fault or a stall has not occurred. When the LED widget turns
red, it indicates a driver fault or a stall has occurred. Fault reporting options can be configured by clicking the
‘Configure’ button.

4.3.4 Register Map

• Enabling the Motor Driver enables the Register page.
• The page can be opened by clicking ‘Pencil’ icon from the side-bar menu
• This page displays all the registers and their fields present on the DRV8434S device.
• The page allows reading and writing any register, field, or bit.
• To read a particular register, click on the register and click ‘Read Register’ button.
• To read all the registers, click ‘Read All Registers’ button
• To update the register values:

– Edit the ‘Value’ field directly to update a register’s hex value.
– Change the field value from the field view at the right of the screen.
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– Double click on any of the register bit to flip the bit (from 0 to 1 or vice versa).
• By default, the write mode is Immediate which writes values to the registers immediately upon change.
• Write mode can be changed to ‘Deferred’ which will write queue all changes and update the device registers

only when ‘Write Register’ or ‘Write All Registers’ is clicked.
• Click on the question mark icon on any register or field to get in-place data sheet help.

Figure 4-10. DRV8434S EVM GUI (Registers Page)

4.3.5 Stall Detection

This section covers different stall detection evaluation methods using the DRV8434S EVM GUI.

4.3.5.1 Learn Stall Threshold

1. Configure desired motion profile in the GUI in Speed Mode. The stall detection will not be available for Step
Mode.

2. Configure device settings as desired. The default values should be acceptable for immediate evaluation. If
motor torque is too high while evaluating, change the 'Full-Scale Current' setting or 'Torque' setting to reduce
it.

3. Click 'Start Input-based STEP' to begin spinning the motor.
4. Enable ‘Stall Detection’ toggle button available on the ‘Stall Detection Panel’.
5. By default, Stall Detection 'Learn Mode’ is set to ‘Enable’.
6. Once the target speed is reached, the microcontroller will write the STL_LRN bit to begin learning the stall

threshold value, STALL_TH.
7. After 16 electrical cycles, the GUI displays the message 'Please stall motor to complete Stall Threshold

learning sequence.'. At this point, the user can physically stall the stepper motor.
8. Once the motor stalls, The nFAULT pin asserts low which turns the Fault indicator on the right panel of the

GUI to RED. If this happens, the STL_LRN_OK and STALL bits should be set, the GUI displays the message
'Stall Threshold learning sequence complete', and the learn result is shown in.

9. To reset the stall fault, remove the stall condition from the motor so it spins again, or click 'Stop Input-based
STEP' to stop the motor. Then click on ‘Clear Fault’ button to clear the stall fault.
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For demonstration purposes, click the 'Reverse direction on stall fault' toggle button. After learning the stall
threshold, this EVM feature will drive the motor until it stalls. After a stall event occurs, the motor will pause
briefly, then begin driving in the opposite direction.

If for some reason stall threshold (STALL_TH) is not properly learned, clicking the ‘Relearn Stall Threshold’
button will tell the EVM to re-run the learning algorithm starting at step 6 in the list above. If the motor is
physically stalled, but the GUI continues to display 'Please stall motor to complete Stall Threshold learning
sequence,'. the DRV8434S may not have properly learned the stall detection threshold. This can happen at low
motor speeds, which cause the stepper back EMF to be low, and a valid STALL_TH value may not be
determined.

Figure 4-11. Stall detection configuration panel in Learn Mode

4.3.5.2 Set Stall Threshold

The stall threshold can be manually set after set 'Learn Mode' to ‘Disable’. In this mode, the user sets the stall
threshold to any desired value. If a valid stall threshold is chosen, the stall fault will be reported as described in
the previous section Section 4.3.5.1. To correctly detect a stall, the stall threshold should be less than the torque
count while the motor is spinning at the desired speed. If the stall threshold value is too close to torque count
value, then false stalls may be detected as the motor torque increases. The 'Reverse direction on stall fault'
toggle button operates the same way as described in the previous 'Learn Stall Threshold' section. Figure 4-12
shows the Stall Detection panel with a manual stall threshold setting.

Figure 4-12. Stall detection configuration panel in Manual Mode

4.3.5.3 Use Register Map

1. Configure desired motion profile in the GUI in Speed Mode. The default values will be acceptable for
immediate evaluation. When configuring stall detection using the register map, it is not necessary to click the
'Stall Detection' toggle button on the Speed Control page.

2. Configure device and motion profile settings as desired. The default values should be acceptable for
immediate evaluation. If motor torque is too high while evaluating, change the 'Full-Scale Current' setting or
'Torque' setting to reduce it.

3. Click 'Start Input-based STEP' to begin spinning the motor.
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4. Go to the Register Map page, and click 'CLR_FLT' in CTRL4 to clear any existing faults. Click 'READ ALL
REGISTERS' to refresh the register map.

5. Once the stepper reaches the target speed, set the STL_LRN bit in the CTRL5 register in the register map.
This will begin the algorithm that learns the stall threshold.

6. After a few seconds, stall the motor. The Fault LED on the board should light, if the STL_REP bit in CTRL5 is
set to 1 (default). The STL bit in the FAULT Status register, and the STALL bit in the DIAG Status 2 register
will also set when a stall condition is detected. Click 'READ ALL REGISTERS' to refresh the register map in
the GUI to see these bits change.

7. To reset the stall fault, remove the stall condition from the motor so it spins again, or click 'Stop Input-based
STEP' to stop the motor. Then click 'CLR_FLT' in CTRL4 to clear the stall fault.

4.3.6

After "Initiate Stall" turns to green, "Stall status" synchonizes to register EN_STL bit.

Clicking "Export Torque Count Values" can allow up to half hour Torque_count values (8ms/sample) save to
torque_values.csv.

4.3.7 Use the Side-Bar Menu

Use the side-bar menu in the left pane to navigate to the different pages at any time. Click on the hamburger
button in the top-left corner of the GUI to expand the side-bar menu. The following pages that are displayed in
the side-bar menu:

• Home
• Registers
• Stepper Motor Control

4.3.8 Menu bar Options

The following menus are available in the menu bar displayed at the top of the GUI as shown in the Figure 4-13.

Figure 4-13. DRV8434S EVM GUI (Menu bar – Help Option)
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4.3.8.1 File Menu

The File Menu has the following options:

• Program Device - The user can load the firmware (.out) file onto the device by clicking this option. For the
firmware load to work, MSP430 FET needs to be plugged into the J2 connector on the EVM board.

• Load/Save Registers – The user can save (and load) a particular configuration of the registers. This saves
time when the user need to reconfigure the registers after power cycle.

4.3.8.2 Options Menu

This menu provides the option to configure the serial port communication settings.

4.3.8.3 Help Menu

The Help Menu contains options to view Readme File and About Section. The about section displays the
installed software information including the application version.
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